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In this course, students develop research skills as they create a Fact Card using Google Docs. 

To start, students brainstorm a topic and plan their research project. Next, they use strategies 

to retrieve quality information from reliable sources. The facts are then processed using 

paraphrasing techniques to transform an outline into a one sheet report. The publication is 
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Introduction 

 

Introduction 
 

This section provides valuable information about teaching TechnoResearch. It 

includes an overview of the course. In addition, there are ideas for 

implementation and technology integration. 

 

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 

 

TechnoResearch Overview 

TechnoResearch Course Outline 

Technology Integration Ideas 
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TechnoResearch Overview 

In this course, students develop research skills as they create a Fact 

Card using Google Docs. To start, students brainstorm a topic and plan 

their research project. Next, they use strategies to retrieve quality 

information from reliable sources. The facts are then processed using 

paraphrasing techniques to transform an outline into a one sheet report. 

The publication is shared with others as a part of a Fun Fact Card 

Collection. Extension activities challenge students to develop skimming 

and scanning techniques, practice advanced research strategies, 

arrange facts in a table, and recognize sources of information. The goal 

of this course is to teach skills that are transferable to any research project. 

Students complete the following tasks: 

➢ In Session 1, students prepare to create a "Fun Fact Card". It is a concise, one-

page summary about a particular topic. To begin, students review a list of

research skills and select areas of interest. They then study sample fact cards to

understand how information is organized. Afterward, they brainstorm ideas for

their own fact card. Using Wikipedia, they conduct initial research on their chosen

topic, which serves as a starting point for narrowing their focus. An optional

activity teaches students skimming and scanning techniques to help them

efficiently gather key information.

➢ In Session 2, students construct a research organizer. It offers a structured

framework with three headings to categorize facts. It also includes sections for a

glossary and listing sources. To assist students, suggestions for popular topics are

provided to help them divide their research into manageable parts. Following

this, students use an online encyclopedia to quickly gather basic facts. They

organize the facts under the appropriate headings. An optional activity explores

the importance of expanding data collection to include both primary and

secondary sources.

➢ In Session 3, students research a topic using Google Search. They learn how to

effectively use keywords and the description to choose a relevant site from the

search results. They then assess the trustworthiness of the source by conducting a

Trust Test. This method is employed to gather facts from two reliable sources.

Additional guidance is provided on narrowing results by domain type, such as

government sites, reputable publications, or research-based television shows. An

optional activity offers further strategies for Google searches, while another

provides tips for recording citations.

➢ In Session 4, students convert their research organizer into a fact card. To begin,

they duplicate the file. They then use the copy to rephrase the information into

their own words. They must eliminate redundant facts, condense text for clarity,

and rearrange the content into a logical sequence. The emphasis is on writing

sentences that are easy for children to read. The fact card will be formatted in

the following session.
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➢ In Session 5, students enhance the design of the fact card. They adjust the font, 

size, and style of one of the headings, then apply these changes to the remaining 

headings. Next, they emphasize the glossary by highlighting terms, adding bullets, 

adjusting line spacing, and applying shading. Information sources are indented. 

Following this, students improve the overall layout by adding a border, setting 

margins, and changing the page orientation. Students include images for visual 

appeal. An optional activity explains how to organize content into columns or a 

table. 

➢ In Session 6, students compile a collection of "Fun Fact Cards". They ensure the 

information is well-organized and easily readable using a checklist. Students then 

print their cards and exchange them with classmates. They explore a variety of 

topics by selecting cards from the collection. Finally, students reflect on their 

research experience, identifying the skills they have acquired and those they will 

apply in the future. 
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TechnoResearch Course Outline 

Purpose: Develop research strategies to 

create a fact card in Google Docs. 

Preparation: 

• Install Google Chrome

• Sign up for a Google Drive account

• Share Research folder with students

• Download and print Flashcards and Tool

Summary from TechnoHub (optional)

Objectives: (see Appendix A: Skill Summary) 

• identify audience and presentation format

• formulate a plan to guide research

• gather information using research strategies

• assess the quality of information

• classify facts using an outline

• define terminology in a glossary

• cite the source using a proper format

• paraphrase facts to avoid plagiarism

• present information clearly on a fact card

• apply word processing skills

• evaluate research procedures and skills

Materials: 

• Assessment Tools: Fact Card Checklist, Research

Self-Reflection, Fact Card Marking Sheet,

Research Skill Summary

• Parent Letters and Certificate (optional)

• Word Flashcards and Tool Summary (optional)

• Research folder

• Samples: Biography, Pioneer, Space, Dust

Storms1, Dust Storms2

Summary of Activities: 

• Assess research skills. Study fact cards to gain an understanding of the research project.

• Use Wikipedia to gain ideas. Build a word list and ask questions to narrow focus.

• Organize ideas. Create an outline with headings in Google Docs.

• Use an online encyclopedia to gather facts. Track the source of information using the Cite feature.

• Research a topic using Google Search. Apply strategies to find trustworthy information quickly.

• Make a glossary that defines terminology using the Define tool or online dictionaries.

• Paraphrase facts by rewriting them using simple sentences that are easy to read and understand.

• Format font, create a bulleted list, adjust line spacing, and indent lines to lay out text on the page.

• Adjust the orientation, page color, and margins. Add images and set the text wrap and borders.

• Complete checklist, then have a peer review the fact card. Make revisions based on assessment.

• Print the fact card or email a link to the teacher. Share collection with others.

Extension Activities: 

• Save Time! Skim and Scan: Apply tips to understand the main point and find specific facts.

• Primary and Secondary Sources: Compare sources to understand their usefulness.

• Explore Google Search: Filter results, find an exact phrase, exclude words, define terms, and more!

• Cite Sources of Information: Understand citations. Use an online generator.

• Arrange Fact Card using a Table: Use table cells to arrange text and images in a columnar design.

Assessment: 

• Self and Peer Evaluation Checklist (Fact Card Checklist – Assignment 10)

• Self-Evaluation (Research Self-Reflection – Assignment 12)

• Teacher Evaluation (Fact Card Marking Sheet, Research Skill Summary)

Notes: 

• This course can be applied to any curriculum unit. Teachers can set the area of study or have

students select the research topic.

• The activities focus on explicitly teaching research skills. The goal is to provide procedures and skills

that are transferable to any research situation.

• Elementary students new to research will benefit from the systematic introduction of skills. The

teacher may want to model the instructions using a direct instruction approach. In addition, it is a

good idea to talk with students about their ideas to make sure their research topic is doable within

the allocated time frame.

• Middle and high school students should complete the extension activities to learn additional

research strategies.

https://technohub.technokids.com/
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Technology Integration Ideas 

TechnoResearch integrates into any curriculum-based research project because the topic is 

open-ended. Teachers can apply it to numerous areas of study within social studies, science, 

history, or geography. The activities include a systematic approach to the development of 

research skills, providing a foundation for future learning.  

 

The course follows stages of the research process. 

• Planning Stage: Students establish a topic and develop a research plan. To start they 

broaden their knowledge to explore the possibilities. Next, they generate a word list to 

highlight what they currently know. From this list, they narrow their focus by posing 

guiding research questions.  

• Information Retrieval Stage: Students gather facts from multiple sources and organize 

them using an outline. They apply research strategies to find trustworthy information 

quickly. Also, they learn how to track sources. 

• Information Processing Stage: Students synthesize information to transform it into a fact 

card for children. To avoid plagiarism, they paraphrase the text into their own words. 

Word processing skills are applied to present findings in an interesting way. 

• Information Sharing Stage: Students present the final product. Fact cards are combined 

with classmates' cards to create a Fun Fact Collection. The collection can be placed in 

the classroom or library or posted to the Internet as a helpful resource to children. 

• Evaluation Stage: Students reflect upon their learning. They assess research procedures 

and skills. Connections are made to how this learning can be applied to future situations. 

 

TechnoResearch fits in with a multitude of teaching situations. 

• Library Media Specialist: A teacher librarian can use the activities to teach essential 

research skills with a focus upon information retrieval, plagiarism, and citing the source. 

• Subject-Specific or Classroom Teacher: The teacher can include the activities as part of 

a curriculum unit to have students acquire knowledge in a meaningful way. 

• Computer Teacher: The computer teacher can use the activities to teach valuable 

Internet search strategies and word processing skills. 

• Language Arts Teacher: The teacher can include the activities as part of the language 

arts unit that focuses upon report writing and organizational strategies. The fact card can 

be easily transformed into a report by adding an introductory and concluding 

paragraph. 

 

 

 

Understand the Big Picture 

 

Not sure where to integrate TechnoResearch? View samples to gain a better understanding of 

the research project. The Pioneer, Space, and Biography Fun Fact Cards showcase a range of 

topics. Study the content, layout, and design. 

 

 



Session 1 Select a Research Topic 

Session 1
Select a Research Topic 

In this session, students prepare to create a "Fun Fact Card". It is a concise, 

one-page summary about a particular topic. To begin, students review a list of 

research skills and select areas of interest. They then study sample fact cards 

to understand how information is organized. Afterward, they brainstorm ideas 

for their own fact card. Using Wikipedia, they conduct initial research on their 

chosen topic, which serves as a starting point for narrowing their focus. An 

optional activity teaches students skimming and scanning techniques to help 

them efficiently gather key information. 

Assignment 1: Study the Fun Fact Card Collection 

Assignment 2: Broaden Then Narrow Your Topic 

Session 1 Extension Activity: Save Time! Skim and Scan 
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Assignment 1: Study the Fun Fact Card Collection 

In this course, you are going to create a Fun Fact Card for kids to use to learn about a topic. The 

fact card will be written for people your age or a bit younger. It will have information, pictures, 

and a glossary. 

 

 

Your fact card will be combined with classmates’ cards to create a Fun Fact 

Card Collection. These fact cards can be printed and placed as a helpful 

resource in the classroom or library. Or you can post them on the Internet as an 

online library, or cybrary, for students at your school. 

 

 

To make a fact card you will use the Internet to research. To make sure you do 

not waste time, you will learn how to find information fast. You will also be given 

tips to assess quality, track sources, and reword information. 

 

 

 

What Research Skills Do You Want to Learn? 

 

You likely already use the Internet to find information. Think about the skills you have.  

Place a checkmark ✓ where you want to learn more time saving tips. 

 

 

 

 

 

Research Skills I have this skill. 
I want to save time. 

Teach me more tips! 

I make a plan before starting a research project.   

I use keywords to find information fast.   

I can pick the best website quickly from search results.   

I know many places on the Internet that have facts.   

I can tell if information on a website is true.   

I can skim and scan information to seek what I need.   

I organize the facts that I gather.    

I keep track of where I find information.   

I rewrite information into my own words.   

I share information with others so that they understand it.   

You have skills, but do you want 

to be even better or faster?  
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Study Fact Cards 

View the Pioneer 1 fact card: 

1. a. The fact card divides information using headings.

Under which heading is information about the reasons 

pioneers used wagon trains to travel?  

Why ride in a wagon train? 

b. A glossary is used to define the meaning of words.

What words are in the glossary?

pioneer, wagon train

c. There are links to websites on the Internet.

Why would this be helpful to someone?

They can learn more about the topic.

View the Pioneer 2 fact card: 

2. a. You are going to learn tips for using Google Docs to

arrange information and images on the page. 

List differences between Pioneer 1 and Pioneer 2 fact cards. 

● 

● 

b. Which fact card do you like more?  Pioneer 1  Pioneer 2

View another fact card such as Space or Biography. 

3. a. Fact Card Name:

b. What do you like about this fact card?

●

● 

4. The fact cards are for kids. The facts must fit onto one sheet of paper.

What do you think is the most important thing kids need to make the information easy to

understand?

The fact cards are in 

the Research folder.  
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Assignment 2: Broaden Then Narrow Your Topic 

You will do a quick Internet search to expand your ideas.  

You will then sort through your options to narrow your research focus.  
 

Follow these tips! 

• Explore Your Topic: Use Wikipedia to learn a bit about the topic. 

• Build Word List: Show what you know. Make a list of terms about your topic. 

• Narrow Your Focus: Think about what you want to learn. Ask questions. 

 

Ask your teacher what general topic you are to study.  

If you get to pick, then choose a topic that interests you.  

 

What is your broad topic area? This is your starting point!  

 

Explore Your Topic in Wikipedia 

 

Wikipedia is a free encyclopedia that has articles written by ordinary people. Anyone can edit 

an article. For these reasons, it is not a good idea to use Wikipedia as your only source of 

information. However, it is a great place to start a research project.  
 

How should you use Wikipedia? 

• learn a bit about a topic quickly 

• view information that relates to your topic to get more ideas 

• connect with other websites related to the topic 

 

 Open the Chrome web browser and visit www.wikipedia.org 

In the search box, type Topic Name. Click Search. 

 Save time! Do NOT read everything, just skim and scan it quickly. 

 Get ideas! Wikipedia can help you expand your ideas. Click around! 

 Be curious! In the search box, add more words to your search term  

or type in a new search word. 

  
 

Read the first paragraph. 

Read the fact list. 

Click keywords to learn more! 

Click article links to learn more! 

Click a heading to read more 

about what interests you. 

Grow what you know! 

This will help you to discover 

what you want to learn.  

http://www.wikipedia.org/
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Build a Word List in a New Document 

Based on your Internet search, you are going to make a list of words related to your topic. 

This is a great way to discover what you already know about a topic.  

You will use this list to narrow your research focus. 

 Close the web browser tab with the Wikipedia article (X).

Sign into Google Drive.

 Click New.   From the list, select Google Docs. 

 Type a Topic Name, then press ENTER.

 Below the Topic Name make a list of words related to your topic.

Press ENTER after each word.

Narrow Your Focus 

You are going to make a Fun Fact Card for kids. 

The card will be one sheet of paper.  

This means you won’t be able to put EVERYTHING onto the card. 

You must narrow your topic. 

 Look over your list. You need to pick a topic for your fact card. Ask yourself:

o What will a kid find interesting?

o What do I want to know more about?

 Pick ONE idea from your list.

Below the list of words, write the NEW Topic Name.

 Below the NEW Topic Name make a list of questions you have about the topic.

Press ENTER after each one.

Rename the Document and Then Sign Out of Google Drive 

 Click in the Untitled Document box to rename the document.

 Sign out of Google Drive.

Topic Name 

word 

word 

word 

word 

NEW Topic Name 

who 

what 

where 

when 

why 

how 

What can be in the list? 

✓ synonyms – different word

used for topic

✓ objects related to topic

✓ places related to topic

✓ people related to topic Jot down as many 

words as you can. 

You will make a research plan in the next assignment. 

Which questions interest you the most? 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Session 5
Format the Fact Card 
Design 

In this session, students enhance the design of the fact card. They adjust the 

font, size, and style of one of the headings, then apply these changes to the 

remaining headings. Next, they emphasize the glossary by highlighting terms, 

adding bullets, adjusting line spacing, and applying shading. Information 

sources are indented. Following this, students improve the overall layout by 

adding a border, setting margins, and changing the page orientation. 

Students include images for visual appeal. An optional activity explains how to 

organize content into columns or a table. 

Assignment 8: Format the Text to Make It Easy to Read 

Assignment 9: Adjust Page Layout and Arrange Images 

Session 5 Extension Activity: Arrange Facts Using a Table 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Assignment 9: Adjust Page Layout and Arrange Images 

Your Fun Fact Card is almost finished. 

Follow the instructions to change the page orientation, color, and margins to 

create a unique design. Insert images to illustrate the ideas. 

Open the Fact Card in Google Docs 

Set the Page Orientation, Color, and Margins 

 From the File menu, select Page setup.

 On the Pages tab:

o Pick an Orientation. Portrait is tall, and Landscape is wide.

o Set the Page color.

o Adjust the Margins.

 Click OK.

Insert an Image Using Google Search 

 Position the cursor where you would like to add a picture.

 Click the Insert menu and pick Image , or click Insert image  on the Docs toolbar. 

 Choose Search the web  from the menu. 

o In the search pane, type a search term. Press ENTER.

o Scroll through the pictures until you find one you like.

o Click on it and then click Insert.

 Select the picture. Drag a corner handle in or out to resize.

Margins 

If you do not have much text, 

make the margins larger such 

as 1.5 or 2 to fill the page. If 

you have lots of text, make the 

margins smaller such as 0.75.  

Page color 

If you are printing the fact card 

keep it white. If you are sharing it 

digitally then pick a color. 

Orientation 

If you are printing, ask your teacher 

which orientation they would like.  
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Change the Text Wrap and Set Picture Margins 

 Choose Wrap text from the toolbar below the selected image.  

 Drag  the picture anywhere on the page.  

 
 

 Click Image margin to change the amount of space between the picture and text. 

 

 

Apply a Picture Border 

 Select the picture. 

 Click Border color.  

From the palette, pick a color. 

 

 Click Border weight.  

From the menu, select an option. 

 

 Click Border dash.  

From the menu, select an option. 

 
  

When you insert a picture, 

it is In line. This means it is 

treated as text. If you want 

to move the picture freely 

you must Wrap text. 

Use Reset image  

to remove ALL edits to a picture. 
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Complete the Fun Fact Card 

 Use your skills to complete the card. Refer to the Design Tips for suggestions.

Sign Out from Google Drive

Fun Fact Card Title 

Heading 1 

The facts are written in your own words. They are easy for 

kids to understand. They tell about the topic in an  

interesting way. 

Heading 2 

The facts are written in your own words. They are easy for kids to 

understand. They tell about the topic in an interesting way. 

Heading 3 

The facts are written in your own words. They are easy for 

kids to understand. They tell about the topic in an 

interesting way. 

Glossary 

❖ term - definition describes the meaning of the word

❖ term - definition describes the meaning of the word

Sources 

Article Title (2015). In Encyclopedia Britannica. Retrieved from 

ttp://www.britannica.com/topic/article 

Author, A. (n.d.). Article Title. Retrieved from http://www.websitewithauthor.com/nodate/article/ 

Article Title. (Year, Month Day). Retrieved Month Day, Year, from 

http://www.websitenoauthor.com/article/ 

Design Tips 

Move Text to the Header or Footer: 

1. If you need more space, select the title.

2. Press CTRL + X on the keyboard.

3. From the Insert menu, select Header & footers. Pick Header.

4. Place the cursor in the header. Press CTRL + V to paste the title.

5. Use your skills to move Sources. TIP: Select Header & footers from the Insert menu and pick

Footer.

Use a Horizontal Line as a Divider: 

1. Place the cursor on the page.

2. From the Insert menu, select Horizontal line.

Separate Information Using White Space: 

• Press ENTER to create space between headings.

• Adjust the line spacing.

• Decrease the font size of less important information.

Recolor a Picture: 

1. Select a picture. Click Image options. Click the Recolor arrow.

2. Click the No Recolor box. Pick an option such as Grayscale.

Complete Session 5 

Extension Activity to 

create a unique design 

by arranging facts using 

a table. 
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Session 5 Extension Activity: Arrange Facts Using a Table 

Use a table to organize information in an interesting way! 

 

1. Open the Fact Card in Google Docs. 

2. Place the cursor at the TOP of the page below the title. 

3. From the Insert menu, select Table.  

Drag to select a table 2 x 4. Click to add it to the page. 

 

 

4. Select the first section of information. For example, Heading 1 and its facts. 

Press CTRL + X on the keyboard to cut it. 

  

5. Place the cursor in the first cell. Press CTRL + V on the keyboard to paste the section. 

 

6. Continue to cut and paste text to move each section into a different table cell. 

TIP: To move pictures into a cell, click In line.  

 

 
 

 
 

7. Get creative! 

 Fill a cell with color.  You may have to click More  to find other tools. 

Use colors from the same column in the palette to create a consistent design. 

 Select the whole table. Add a border color.  

Pick white to divide each block of cells. 

 

 Set the border weight.  

To remove borders select 0pt. 

 Combine cells together. Select the cells. 

Right click on the selection and choose Merge cells.  

8. Sign out of Google Drive. 

 

 

 

Table Design Tips: 

• Need more rows? From the Format menu, click Table and Insert rows above or Insert rows below. 

• Need more columns? From the Format menu, click Table and choose Insert column left or Insert 

column right. 

• Have too many cells? Place the cursor in the row or cell you want to remove. From the Format 

menu, click Table and choose Delete row. 

Resize the column width to 

adjust how the information 

fits inside the cells. 



Session 6 Share the Fact Card 

Session 6
Share the Fact Card 

In this session, students compile a collection of "Fun Fact Cards". They ensure 

the information is well-organized and easily readable using a checklist. 

Students then print their cards and exchange them with classmates. They 

explore a variety of topics by selecting cards from the collection. Finally, 

students reflect on their research experience, identifying the skills they have 

acquired and those they will apply in the future. 

Assignment 10: Fact Card Checklist 

Assignment 11: Create a Fun Fact Card Collection 

Assignment 12: Research Self-Reflection 
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Assignment 12: Research Self-Reflection 

What did you learn from completing the research project? 

What skills do you think you will use again? 

1. You learned many tips for narrowing a topic. Check the tips you would use again.

 Explore your topic to get ideas using the Internet. 

 Use Wikipedia to learn a bit about a topic. 

 Build a word list of terms related to your topic. Pick an idea from the list. 

 Think about what you want to learn. Make a list of research questions. 

2. You learned to find quality information fast. Check the tips you would use again.

 Use an online encyclopedia as a starting point for a research project. 

 Use keywords suggested by Google Search. 

 Skim search results by reading the titles only to find the best one. 

 Scan a search result description to make sure it has facts that are needed. 

 Look for a reliable source of information in the search result title or web address. 

 Give a web page a “Trust Test” before reading the information. 

 Limit results to a trusted source using site:website topic as the search term. 

 Use the Define tool in Google Docs or an online dictionary to define terms. 

3. You learned to organize facts. Check the tips you would use again.

 Create an outline with headings to sort facts. 

 Color-code facts to identify the source used to find the information. 

 Copy and paste facts from a web page to gather information quickly. 

 Remove formatting from facts to make them easier to work with later. 

 Track the sources of information as you research information. 

4. List search strategies you used during the research project that were helpful.
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5. You learned to put information in your own words so that you did not plagiarize.  

Check the tips you would use again. 

  Rewrite large blocks of text into only one or two sentences. 

  Delete facts you do not need because they are repetitive or uninteresting. 

  State ideas simply using words that are easy to read and understand. 

 

 

6. You learned to arrange information in an interesting way using Google Docs. 

Check the tips you would use again. 

  Make a copy of an outline to keep the original research intact. 

  Copy formatting to text using Paint Format to create a consistent design. 

  Organize information using a bulleted list. 

  Adjust page setup (orientation, color, and margins) to create a unique layout. 

  Set the image margin to add white space between a picture and text. 

 

 

7. You made a Fun Fact Card using Google Docs.  

List three other publications you could create using Google Docs. 
  

  

  

  

 

 

8. What advice will you give to help a person save time when doing a research project? 
  

  

  

  

  

 

 

 

 



Appendices 

Appendices

Refer to the appendices for additional resources: 

Appendix A: Assessment Tools 

Appendix B: Contact Information 
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Fact Card Marking Sheet 

Organization 

• Title tells about the topic. It stands out on the page.

• Headings divide information into parts and tell about each group of facts.

• Glossary defines important words related to the topic using a bulleted list.

• Sources are listed using the proper format. There are at least 3 sources.

• Information is logically organized.

/10 

Quality of Information 

• The Fun Fact Card is interesting and informative.

• Facts are rewritten using student’s own words.

• Information is from reliable sources that are trustworthy.

• The text is easy for kids to read and understand.

• There are no spelling or grammar errors.

/10 

Design 

• Pictures illustrate the topic and are well-formatted.

• The text formatting and color choices make the fact card look good.

• Information has been arranged to fit on one page.

• White space is used to separate information, so it is easy to read.

• Page has a unique design.

/5 

Comments: 

/25 



 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

This course includes a sample of a completed project. 
Teachers can use this resource for demonstration purposes 

or as a source of inspiration. 

 

 

 

 

 

 



W a g on  Tr a i n s i n  th e Am er i ca n  W est  

Sources 
 

Wagon Train. (2015). In Encyclopædia Britannica. Retrieved from http://www.britannica.com/topic/wagon-train/ 
National Historic Oregon Trail Interpretive Center. (n.d.). Frequently Asked Questions. Retrieved from http://www.blm.gov/or/oregontrail/history-faqs.php/ 
Simkin, J. (2014, August). Wagon Train. Retrieved from http://spartacus-educational.com/WWwagontrain.htm/ 

 

What is a wagon train? 
During the late 18th and most of the 19th centuries pioneers drove across the American West in wagon trains. A 
wagon train is a group of wagons pulled by oxen or horses. The train could have up to 100 wagons. Famous trails 
settlers followed were the Santa Fe Trail and the Oregon Trail. 
 
Who rode in a wagon train? 
Traders, explorers, miners, hunters, missionaries, and farmers drove in wagon trains. The wagons were protected by 
a few men on horseback with guns. 
 
Where were the wagon trains going? 
The wagon trains were going West towards California, Missouri, and other places across the Mississippi River. They were going 

there because the lands were ideal for farming, mining, and hunting. 
 
Why ride in a wagon train? 
Pioneers were going West because land was inexpensive and there were 
business opportunities. The people were in groups because it was safer. 
Crossing rivers and mountains was dangerous. Also there was the risk of 
attacks. Pioneers were stronger together, than alone. 
 
 

How were the wagon trains made? 
Groups of people would start to gather in early Spring in a town. They would form companies, pick officers, hire guides, and collect 
supplies. In May they would start to travel down the trail as a group. The wagons would drive all day, not stopping until it was time to 
make dinner and let the animals graze. 
 
Glossary 

❖ Pioneer: A person who is among the first to explore or settle a new country or area. 

❖ Wagon Train: A convoy or train of covered horse-drawn wagons, as used by pioneers or settlers in North America. 

http://www.britannica.com/topic/wagon-train


Pauline Johnson 

Family History 
Emily Pauline Johnson was born on the Six Nations of the Grand River reserve near Brantford, Ontario, 

Canada. She was of mixed heritage. Her father was a native chief who spoke English and Mohawk. He 

served as a missionary translator. Pauline's mother came from England to work with the missionaries. Not 

everyone was happy about their marriage. When her father died Pauline was 23 years old. Her family 

moved into Brantford and did not have much money. 

 

Poet and Author 
Pauline liked to read both classic English authors and books about Indigenous 

peoples. In her teens, Pauline began to write poems. Her poetry was mostly 

about the Canadian landscape, but she also made ballads about First Nations 

history. For example, her poem “A Cry From an Indian Wife” is about the Riel 

Rebellion. One of her most famous poems is "The Song My Paddle Sings". As 

an adult, many of her writings were published in  newspapers and magazines. 

Later her collection of poems was printed in a book called "Flint and Feather". 

 

Stage Career 

To support herself, Pauline became a performer, telling stories and poems in salons and theaters. Her 

promoter called her the Mohawk Princess.  She took the stage name Tekahionwake, which was her 

great-grandfather’s name. It means 'double wampum' or double life. She wrote and performed a two-part 

act. In act one, she would recite Mohawk lyrics, wearing a buckskin dress with a bear claw necklace, 

wampum belts, and masks. In act two, she would come out in a silk English gown and recite poetry. The 

audience would gasp at the change. 

 

Achievements and Legacy 

Pauline was one Canada’s first performance artists. But more importantly, she was an 

activist who defended Indigenous rights. Her work brought people’s attention to 

stereotypes and the cruel treatment of the Indigenous peoples. As well, Pauline was an 

advocate for women. She did not agree that women should find a husband, stay home, 

and be dutiful. Instead, her stories show women as independent, noble, and brave.  

 

Quotes 

"I am a Redskin, but I am something else, too - I am a 
woman."  
 
"Forget that I was Pauline Johnson, but remember that 
I was Tekahionwake, the Mohawk that humbly aspired 
to be the saga singer of her people." 

Glossary 

❖ Wampum: colored beads often made from shells 

that were woven in a pattern, to be worn in 

ceremonies, for decoration, or used as money 

❖ Indigenous Peoples: a group that has always lived  
in a specific place and are native to the land 

 

Sources 

Robinson, Amanda. "Pauline Johnson (Tekahionwake)".  The Canadian Encyclopedia, 24 January 2020, Historica Canada. 

https://www.thecanadianencyclopedia.ca/en/article/pauline-johnson. Accessed 01 October 2021. 

 

"Johnson, E. Pauline (1861–1913) ." Women in World History: A Biographical Encyclopedia. . Retrieved September 23, 2021 from 

Encyclopedia.com: https://www.encyclopedia.com/women/encyclopedias-almanacs-transcripts-and-maps/johnson-e-pauline-1861-1913 

 

Gray, Charlotte. “The true story of Pauline Johnson: poet, provocateur and champion of Indigenous rights." Canadian Geographic, 08 

March 2017, https://www.canadiangeographic.ca/article/true-story-pauline-johnson-poet-provocateur-and-champion-indigenous-rights 



     

Dawn Spacecraft  
 

 

What is the Dawn Spacecraft? 
The Dawn spacecraft is a United States satellite that orbited the large asteroid 

Vesta and the dwarf planet Ceres.  

 

When Did it Launch? 
After lots of delays, Dawn was finally launched on September 27, 2007 from Cape 

Canaveral in Florida.  

 

How is it Powered? 
Dawn uses solar-electric propulsion. It has three xenon-ion thrusters that produce a LOT of power. Dawn uses electricity 

that is created from solar panels to power the xenon. The xenon thrusters help to get the spacecraft from Earth to Ceres 

and Vesta, but more powerful thrusters will be used for orbit. 
 

Where Was its Orbit? 
Dawn traveled from Earth into space. It flew past Mars in 2009, then changed its path toward the asteroid belt. Dawn 

arrived at Vesta in July of 2011, and circled around the asteroid gathering information until September of 2012. Then it left 

for Ceres. It arrived at Ceres in March of 2015.  
 

What is its Purpose? 
By studying both Vesta and Ceres from the same spacecraft, the Dawn mission hopes to compare the different path each 

took as well as learn about the early solar system. Information from the Dawn spacecraft could teach us how the solar 

system was formed. 
 

What Information has it Reported? 
Dawn is taking pictures and sending them back to Earth. It also has special cameras that can see the surface of Vesta 

and Ceres. It is also getting information about gravity and what the asteroids are made of. This can help scientists to 

understand the history and role of water when the asteroids were created. We may even learn if meteorites found on 

Earth come from these asteroids. 
 

Glossary 
● orbit: A regular, repeating path that one object in space takes around another one. 

● satellite: a celestial body orbiting the Earth or another planet. 

● asteroid: a small rocky body orbiting the sun ranging in size from nearly 600 miles (1,000 km) across (Ceres) to 

dust particles. 

● propulsion: the action of driving or pushing forward. 

● solar-electric propulsion: A form of ionic propulsion in which the power for the ion engine is provided by solar 

cells. 

 

Sources 
Dawn. (2015). In Encyclopædia Britannica. Retrieved from http://www.britannica.com/topic/Dawn-United-States-satellite 

 

Dawn Mission Overview. (2015, July 30). Retrieved from http://www.nasa.gov/mission_pages/dawn/mission/index.html 
 

Space Facts. (2015). Retrieved from http://space-facts.com/dawn-spacecraft/ 
 

Dawn. (2015, December). Retrieved from http://nssdc.gsfc.nasa.gov/nmc/spacecraftDisplay.do?id=2007-043A 

http://www.britannica.com/topic/Dawn-United-States-satellite
http://www.nasa.gov/mission_pages/dawn/mission/index.html
http://space-facts.com/dawn-spacecraft/
http://nssdc.gsfc.nasa.gov/nmc/spacecraftDisplay.do?id=2007-043A
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